
Lesson 3: Geometric correction of an aerial image 

3:  GEOMETRIC CORRECTION OF AN AERIAL IMAGE OF  
SOUTH CAICOS ISLAND 

 

 

Aim of Lesson 
To learn how to rectify an image to a Universal Transverse Mercator (UTM) coordinate system and to 
understand why it is important to carry out geometric correction of remotely sensed images. 

Objectives 
1. To understand that measurements made from images that have not been geometrically 

corrected can be misleading and that just because an image looks like a map it does not 
necessarily have the properties of a map.  

2. To learn how to make measurements of distances between points on an image using 
Pythagoras’s theorem so that you can compare distances between known points before 
and after rectification and georeferencing of the image.  

3. To discover how Ground Control Points (GCPs) are obtained at selected positions, 
which are carefully chosen to be readily identifiable on the image, using a Global 
Positioning System (GPS) so that the geographical coordinates of a series of pixels can 
be linked together in a rectification table. 

4. To understand how a rectification table works by linking pixels at know column and row 
coordinates to GCPs at know geographical (in this case-study, Universal Transverse 
Mercator) coordinates obtained using a GPS. 

5. To use Bilko to enter details of three GCPs in the rectification table and learn how to 
select an appropriate transformation (linear, quadratic or cubic) for rectification. 

6. To understand what Root Mean Square (RMS) error means and find out how to deselect 
problem GCPs that have unacceptably high RMS errors (perhaps due to a GPS error or 
human error in transcribing coordinates).  

7. To carry out rectification and resampling of the image to the Universal Transverse 
Mercator (UTM) grid system of local maps of the Turks & Caicos Islands. 

8. To compare measurements between points on the geometrically corrected and 
uncorrected images and see how much positional error may result from using 
uncorrected imagery. 

Background Information 
This lesson relates to material covered in Chapter 6 of the Remote Sensing Handbook for Tropical 
Coastal Management and you are recommended to consult this or a range of other remote sensing 
texts (e.g., Mather, 1999; Wilkie and Finn, 1996; ERDAS, 1994) for further details of the theory and 
techniques of geometric correction.  

The Bilko 3 image processing software 
Familiarity with Bilko 3 is required to carry out this lesson. In particular, you will need experience of 
using Transects and Edit, Go To to find out distances between points. A familiarity with switching 
geographical coordinates on and off using the View, Coords feature, connecting images using 
Image, Connect, and with the Excel spreadsheet package is also desirable. Tutorials 2, 3, 7 and the 
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first part of Tutorial 8 in the Introduction to using Bilko are particularly relevant and provide a good 
grounding for this lesson. 

Image data 
For this lesson, you are presented with part of a scanned black and white aerial photograph of South 
Caicos Island, which, you are told, was taken in 1981. You want to use this image to look at how parts 
of the island have changed and thus need to geometrically correct it and georeference it to the local 
map, which uses Universal Transverse Mercator (UTM grid zone 19 N) coordinates, so that you can 
compare it with other similarly georeferenced images taken at later dates. The local maps (Ordnance 
Survey map Series E8112 DOS 309P) also use the Clarke 1866 spheroid and NAD (North American 
Datum) 27 (Bahamas) datum. A spheroid tries to account for the fact that the Earth is not a sphere but 
an oblate spheroid. The Clarke 1866 spheroid is appropriate for and often used in North and Central 
America and the Caribbean. A geodetic datum is a smooth mathematical surface that closely fits the 
mean sea-level surface in a specific area of interest. The NAD 27 (Bahamas) datum is appropriate for 
the Bahamas (except San Salvador Island) and the Turks & Caicos Islands. For further details of the 
UTM Grid System, spheroids and datums, a useful reference is Butler et al. (1987).  

You are not quite sure whether the image was taken professionally or is a near vertical with significant 
distortion. You are told that the image was scanned so that the pixel size is approximately 3.5 m x 3.5 
m but want to check this. 

Field survey data 
In order to carry out geometric correction we have looked for obvious points visible on the aerial 
photograph such as crossroads, corners of prominent buildings, corners of salinas (salt ponds), 
seaward or landward ends of jetties or piers, and ends of the airstrip, and then gone out with a Global 
Positioning System (GPS) to obtain the UTM coordinates of a series of ground control points (GCPs) 
scattered over the area covered by the aerial photograph. The location of each GCP was determined 
using a Differential Global Positioning System (DGPS) with a probable circle error of 2–5 m1. Their 
position was marked on a print out of the aerial and notes made of exactly where each GPS reading 
was taken to aid matching of column and row coordinates on the scanned image of the aerial to UTM 
Eastings and Northings of GCPs. We have entered most of the GCPs into a Bilko rectification table to 
save you time. 

Geometric correction 
Raw remotely sensed imagery is usually distorted in some way. Geometric correction of remotely 
sensed imagery is carried out so that (i) it can be represented on a plane (e.g. flat sheet of paper), (ii) it 
can be used like a map, or (iii) it will conform to other images to which you wish to compare it. 
Rectification is the process of projecting data onto a plane and making it conform to a map projection 
system such as the UTM Grid System. During the process of rectification the grid of raw data (usually 
just column and row coordinates) must be transformed onto a new grid (usually a map coordinate 
system). For UTM this new grid consists of Eastings and Northings in metres from a “false” origin. 
Resampling is the process of interpolating data values for pixels on the new grid from the values of the 
source pixels. Georeferencing is the process of assigning map coordinates to image data.  

Sometimes you have geometrically corrected images of the same area, which have been rectified to 
different grid systems (e.g. one image might have been rectified to UTM zone 30 (Northern 
Hemisphere) with WGS 84 spheroid/datum and another to the UK National Grid using Airy (1844) 
spheroid and Ordnance Survey of Great Britain 1936 datum with a Transverse Mercator projection). If 
you wish to compare such images, you need to rectify and resample one image to conform to the other. 

                                                      
1 With more modern equipment and removal of “selective availability” error by US Department of Defense you 
would expect to achieve somewhat better accuracy nowadays. 
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The process of making image data conform to another image is called registration and need not 
necessarily involve a map coordinate system. 

To rectify an image you need to relate specific pixels in the image to known map coordinates. The 
map coordinates of objects, which are clearly recognisable both on the ground and on the image, may 
be obtained from large-scale maps, directly using a GPS or from other images that are already 
georeferenced. The Bilko rectification table allows you link raw image pixels at known column and 
row coordinates with known map coordinates. Each linked pixel is a GCP. When you have enough 
GCPs you can get the computer to calculate a transformation, which maps the raw image grid to the 
new grid. For a linear transform you need an absolute minimum of 3 GCPs, for a quadratic transform a 
minimum of 6 GCPs, and for a cubic transform a minimum of 10 GCPs. However, you should try to 
use as many as can be easily obtained (up to 20 or more for quadratic or cubic transforms) and have 
them as evenly distributed across the image as possible. 

To assess the goodness of fit of both the overall transform and individual GCPs, the inverse of the 
transformation matrix is used to retransform the reference coordinates of the GCPs back to the source 
coordinate system. Unless there is a perfect fit of the GCPs (unlikely!) to the curve described by the 
linear, quadratic or cubic transformation used, then some discrepancy (error) will exist between the 
original source coordinates and the retransformed coordinates. The distance between the input (source) 
location of a GCP and the retransformed coordinates of the same GCP is called the Root Mean Square 
(RMS) error. This is calculated for you in the rectification table as follows: 

RMS error = ( ) ( )22
irir yyxx −+−  

where xi and yi are the input (source) coordinates, and xr and yr are the retransformed coordinates (see 
Figure 3.1 below). You can use the overall RMS error (the square root of the sum of squares of the 
individual RMS errors divided by the number of GCPs used in the transformation process) to judge 
which transform is most appropriate and use the individual RMS errors to see if any GCPs have 
unacceptably high errors and should be removed from the transformation calculation to improve the 
fit. 

Input (source) GCP

Retransformed 
GCP

x r - x i

y r - y i
RMS Error

( ) ( )22
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(x r  , y r )

(x i  , y i )
x residual
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Figure 3.1. The calculation of the RMS error of an individual GCP. 
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Lesson Outline 

Inspecting the uncorrected scanned aerial photograph 
You have been presented with a scanned black-and-white (monochrome) aerial image from 1981. 
Before attempting to geometrically correct the image you will examine it so that you can better 
understand the need for geometric correction and consequences of not doing it. 

Activity: Launch Bilko, select File, Open and make sure that Extract checkbox is checked and 
Minimize checkbox is unchecked. Then open the 8-bit integer image file 
Aerial_subimage_raw.gif noting the size of the image [Hint: remember to account for 
the fact that the first pixel is at coordinates (0, 0)]. Examine the image and identify the 
airstrip across the top of the image, the disused salinas (salt ponds) covering most of the 
centre of the image, the settlement in the bottom left (south-west) and the very dark strip 
of mangrove along the coast to the north of the settlement. 

Question: 3.1. How many columns and rows of pixels does the Aerial_subimage_raw.gif have?  

Question: 3.2. How many kilometres is the top of the image across if you assume that each pixel is 
3.5 m wide?  

To see the kind of effects that using an uncorrected image might cause, you will estimate the length of 
the tarmac on the runway both before geometrically correcting the image and after the image has been 
corrected. You have been told that the pixel size is 3.5 m x 3.5 m. Using this information and 
Pythagoras’s theorem you can estimate the runway length. Pythagoras’s theorem tells us that for right-
angled triangles: 

( ) ( )22 direction Yin  Distancedirection Xin  Distancehypotenuse ofLength +=  

This allows us to work out the diagonal distance (length of hypotenuse) between any two points on the 
image. Note that it is often easier to work out distances in pixels and then multiply the final result by 
the pixel size. 

Activity: Click on the transect button and with the mouse lay a transect along the middle of the 
tarmac from the western end of the tarmac landing strip to the eastern end. Select File, 
New and then TRANSECT Document to display the transect. Make a note of the 
column and row coordinates at the start and end of the transect. Use this information (or 
Edit, Go To) to find the distances in the X and Y directions between the points at 
either end of the transect and then use Pythagoras’s theorem to estimate the diagonal 
distance in metres along the runway tarmac.  

Question: 3.3. What is the estimated length in metres (to the nearest m) of the runway tarmac?  

Geometric correction of the scanned aerial photograph 
The next stage is to match pixels at particular column and row coordinates to Ground Control Points 
(GCPs) where readings of UTM coordinates have been made. To save you time 24 GCPs have already 
been entered into the rectification table South_Caicos_GCPs.tbl.  

Activity: Close the transect document. Select File, Open and set Files of Type: to TABLES 
(*.tbl), then select South_Caicos_GCPs.tbl as the rectification table and click on 

 to open the table. Note that the Master: column is set to Use Map 
(Gridded) and contains the UTM coordinates of the GCPs, whereas the Slave: column 
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is set to the Aerial_subimage_raw.gif image and contains the row and column 
coordinates for the GCPs.  

Initially the transform is set to Linear. The average Root Mean Square (RMS) error is 
shown at the head of the last column. Its units are pixels. Note that the GCPs are now 
displayed in yellow on the image. Inspect the image and note that the GCPs are 
reasonably evenly distributed over the image. When you have satisfied yourself of this, 
make the rectification table the active window and answer the following questions. 

Question: 3.4. (a). What is the average RMS error for a linear transform? (b). What is this 
expressed in metres (assuming a pixel size of 3.5 m)? [Express answer to nearest 0.1 m.] 

Activity: Right-click on the rectification table and change the Transform to quadratic. Note the 
dramatic improvement in the average RMS error. 

Question: 3.5. (a). What is the average RMS error for a quadratic transform? (b). What is this 
expressed in metres (assuming a pixel size of 3.5 m)? [Express answer to nearest 0.1 m.] 

Activity: Right-click on the rectification table and change the Transform to cubic. Note the slight 
improvement in the average RMS error. 

Question: 3.6. (a). What is the average RMS error for a cubic transform? (b). What is this 
expressed in metres (assuming a pixel size of 3.5 m)? [Express answer to nearest 0.1 m.] 

The huge improvement in the RMS error when the transform is changed from linear to quadratic 
suggests that a linear transform is totally inadequate to correct the distortions of this image. By 
contrast, the relatively minor improvement in the RMS error when the transform is changed from 
quadratic to cubic suggests that a quadratic transform is probably sufficient. Using a higher power 
transform will always improve the fit (reduce the overall RMS error) but cubic transformations are 
seldom necessary.  

Given a 2–5 m probably circle error for the DGPS fixes as well as the likelihood of at least a one pixel 
(3.5 m) error in the X and/or Y direction in identifying the correct column and row coordinate on the 
image, an overall RMS error of around 5 m seems about as good as one is likely to get with the DGPS 
and image being used. 

 

24 

26 

25 

Figure 3.2. Locations of GCPs #24 to #26 on the scanned aerial photograph. 
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The next stage is to enter the three remaining GCPs into the rectification table. The differential GPS 
readings for these three GCPs are listed in Table 3.1 below and their locations on the image shown in 
Figure 3.2 above. 

Table 3.1. Global Positioning System UTM coordinates for GCPs#24 to #26. 

 Description Easting Northing 

GCP#24  Centre of crossroads in town (north)  237437.5 2379087.5 

GCP#25  Centre of crossroads in town (south)  237850.0 2378512.5 

GCP#26  Salt pond boundary wall corner 238431.3 2378793.8 

Activity: In the rectification table click on the Description for GCP#024 and type in the 
description for this GCP, then press the <Tab> key and enter the Easting and Northing 
separated by a space or a comma. At this point switch to the Aerial_subimage_raw.gif 
image and position the cursor as close as possible to the exact centre of the crossroads 
indicated in Figure 3.1 using the mouse. Then use the arrow keys with <Ctrl> depressed 
for final positioning. [Hint: It is easier if you zoom in to 200% to 400% to do this]. 
When you are satisfied that the cursor crosshair is right in the middle of the crossroads, 
press the <Insert> key to insert the column and row coordinates into the rectification 
table. [The correct column and row coordinates are (214, 685) and you should be within 
1 pixel of these coordinates]. 

 Repeat the process for GCPs #25 and #26. When all GCPs have been entered, right-
click on the rectification table and make sure that the Transform is set to Quadratic. 
Check the average RMS for all 27 GCPs [remember: first GCP is #000]. This should be 
approximately 1.5. If not, then check that your new GCPs are correctly located! 

Question: 3.7. (a). What column and row coordinates do you have for GCP#25? (b). What column 
and row coordinates do you have for GCP#26? (c). What is the average RMS error for 
all 27 GCPs?  

You now have a good series of fairly evenly spaced GCPs scattered across the most of the image. This 
should allow good rectification of the scanned aerial photograph with good confidence in the results. 
Before doing this you should note two further points about the raw image. 

Activity: Firstly, although you have established details of the UTM Eastings and Northings and 
corresponding column and row coordinates for 27 GCPs in the image in the rectification 
table, if you click on the image you still only see column and row coordinates returned 
on the Status bar. Check this out. Note also that in the View menu, you do not have the 
option to view Coords. 

Secondly, note if you hover the mouse pointer over the cross marking the position of 
each GCP you will see a pop-up that shows the GCP number and its description. If 
GCPs are very close to the image edge so that the yellow numbers are not fully visible, 
this is useful.  

Finally, you need to check whether any individual GCPs are likely to spoil the fit of the image, that is, 
have anomalously large RMS errors associated with them. For the purposes of this exercise it has been 
decided that GCPs with RMS errors greater than 10 m should be rejected.  

Activity: Work out how many pixels (to 2 decimal places) 10 m is equivalent to. Then check the 
rectification table to find out if there are any potentially problematic pixels that should 
be rejected.  

Question: 3.8. (a). Which GCP has the greatest (worst) RMS error? (b). What is this error in 
pixels? (c). Should this GCP be rejected on the basis of the criterion stated above? 
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Activity: You should have found a single GCP that needs to be rejected. Uncheck the checkbox 
for this GCP in the rectification table so that it is displayed in cyan on the image. The 
average RMS error should reduce to approximately 1.368 pixels (about 4.8 m). 

At this point you need to link the UTM coordinates to the image and fix the transform prior to 
resampling. This is done by copying the rectification table to the clipboard and then pasting it to the 
image.  

Activity: Click on the rectification table so that it is the active document and select the Copy 
button to copy the table. Now click on the Aerial_subimage_raw.gif image and click 
on the Paste button. Note that View, Coords can now be activated and that UTM 
coordinates now appear on the Status bar. If you position the cursor on the centre of the 
cross for any GCP, the Status bar will now show the coordinates of the centre of the 
pixel in which the GCP occurs. Compare the Status bar positions (pixel centres) for one 
or two GCPs with the UTM coordinates (read off the GPS) that are listed for the GCPs 
in the rectification table. Values should usually be within a few metres for both Eastings 
and Northings.  

Although the computer can now calculate the UTM coordinates of each pixel, the image geometry has 
not yet been warped to display the image correctly in the new coordinate system. For this to occur the 
image must be resampled and redisplayed on a UTM grid.  

Activity: With the image as the active document, select Image, Resample. This brings up the 
Resample dialog box with four tabs: Window, Pixel, Image and Interpolation. For 
the interpolation method, select Cubic convolution2 and click the Apply button. Then 
click on the Window tab and set the Easting (X): to 236670 to: 240290 and Northing 
(Y): to 2381490 to: 2378110 and click the Apply button. This provides a window 
sufficiently large to accommodate a bit of warping of the original image (slightly larger 
than the original image in each dimension). Next click on the Pixel tab and set both 
pixel Width: and Height: to 3.5 (i.e. 3.5 m) and click Apply. [The default settings of 3.6 
and 3.4 suggest that some warping is needed.] The original image was 990 columns by 
980 rows. Click on the Image tab to find out the size of the new image in rows and 
columns. 

Question: 3.9. What size is the resampled image going to be in columns and rows?  

The original image was the same width at top and bottom. You will now check to see whether 
geometric correction has changed this, by comparing the length of two transects, one at the top of the 
image and one at the bottom. 

Activity: When you have applied the correct settings for interpolation, window and pixel size, 
click on OK to carry out the resampling. Select the resampled image and lay a 
horizontal transect from west to east from the top left hand corner of the image at 
column and row coordinates (1, 10) to the last non-zero pixel in that row at coordinates 
(1033, 10). Find out the east-west distance across top of the image [Hint: switch to 
viewing UTM coordinates once the transect is in place]. Starting at the bottom right of 
the image – column and row coordinates (983, 951) – draw a horizontal transect to the 
first non-zero pixel in the same row and measure the east-west distance across the 
bottom of the image. 

Question: 3.10. (a). What is the distance in metres across the top of the resampled image (to pixel 
edges) – from column and row coordinates (1, 10) to (1033, 10)? (b). What is the 

                                                      
2 In this instance we are looking to achieve a reasonably smooth resampled image and are not interested in 
preserving spectral values; thus Cubic convolution is perhaps the best method and Bilinear interpretation which 
involves some averaging of pixel values would also be appropriate.  

 7 



Applications of satellite and airborne image data to coastal management 

distance in metres across the bottom of the resampled image (to pixel edges) – from 
column and row coordinates (983, 951) to (5, 951)? (c). What is the difference in 
distance across the image between rows 10 and 951 (not counting zero value pixels!)? 

Question: 3.11. What do you estimate the length in metres (to the nearest m) of the runway tarmac 
to be now, using the geometrically corrected resampled image? 

Question: 3.12. How wrong was your estimate of the runway length using the raw (uncorrected) 
image?  

The answers to questions 3.10 to 3.12 show you how important geometric correction is. If you had just 
assumed the aerial photograph was a true (undistorted, map-like) representation of the area, you would 
have made considerable errors, underestimating distances in the north of the image and overestimating 
distances in the south of the image due to the slightly oblique angle at which the image was taken.  

To see more clearly how the aerial photograph was distorted, you will now stack the raw and 
geometrically corrected images in same sized windows with their top left corners mapped to the same 
point. From your earlier study of the resampled image you know that its top left hand corner is at 
column and row coordinates (1, 10) in the resampled image window. You thus need to (i) copy the raw 
image, (ii) make sure the image cursor is on column and row coordinate (1, 10) in a blank image the 
same size as the resampled image, and (iii) paste the raw image into the window.  

Activity: Firstly, you need to retrieve a version of the raw image without the UTM coordinates 
applied. To do this, close the rectification table and the Aerial_subimage_raw.gif 
image. Then reopen the Aerial_subimage_raw.gif image, which will now be as it was 
before you started rectifying it. Select all of the image and Copy it. 

With the geometrically corrected image as the active image select Image, Connect 
and connect the image to one blank in a stack. Select the blank image using the 
Selector drop-down list. Using either Edit, Go To or the mouse and arrow keys, 
place the image cursor on coordinates (1, 10). Paste the raw image into the blank 
window. Zoom out so that you can see the whole image and click on the Loop button 

 (or select Image, Animate and click on OK). You will see clearly that the original 
aerial photograph was considerably distorted. When you have finished close all images.  

The amount of distortion suggests that the original aerial photograph, of which the image was a part, 
was perhaps not flown as part of a vertical aerial survey or has become distorted with time. A normal 
aerial survey photograph would be expected to require much less geometric correction whilst near-
vertical photographs taken from hand-held cameras (and thus likely to be somewhat oblique) would be 
expected to require considerable correction.  
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